
Chapter 1

Design Process Management

After the installation is complete, a new program group called ACTIVE-
CAD will appear (Figure 1-1). It may contain some or all of the following
ACTIVE-CAD icons:

r Project Manager; allows to control the entire project environment, in-
cluding ACTIVE-CAD programs and other vendor’s EDA tools.

r Schematic Editor; starts hierarchical schematic editor.
r Simulator; starts functional and timing simulators which work on-line

(real-time) with the schematic editor.
r Library Manager; allows to select additional libraries and create new

models, including clones of existing models.
r Test Vector Editor; it is an independent off-line application. Several test

vector editors are also available from the simulator program.
r Symbol Editor; allows creating symbols for schematic and FSM editors.
r Key Utilities; lists authorized software products, options and libraries.
r Uninstall; removes all ACTIVE-CAD files from the hard disk.
r Release Notes; lists software upgrades and newly discovered bugs.
r VHDL; it is a 1076-IEEE VHDL editor and compiler
r MOBIC; compiles Boolean equations into fast functional models.
r State Machine Editor; used for entry of designs as “bubble” diagrams.
r Static Timing Analyzer; calculates all possible design timing violations.



Project Manager
Project Manager controls the entire design process. It keeps track of the
design revision levels, libraries, macros, test vector files and other design
resources used in the design process. It is automatically activated by all
ACTIVE-CAD applications. For example, starting schematic editor will
automatically open Project Manager, which will be listed in the taskbar
of Windows 95 or displayed as a minimized icon in Windows 3.1 and NT.

Project Manager can also be opened from the File menu of several
ACTIVE-CAD applications such as schematic editor and logic simulator.

Double clicking on the ACTIVE-CAD icon in Figure 1-1 starts the Project
Manager and displays a screen with menus, icons, design hierarchy and
a flow diagram with buttons for invoking various design applications
(Figure 1-2). The last design will be automatically loaded and the Project
Manager will be configured for that application. This means that all
ACTIVE-CAD files and applications and other programs such as XACT,
X-BLOX, ACTMAP, EXEMPLAR, etc., may be loaded and displayed as
control buttons in the design flow diagram.

The Project Manager performs the following functions:

r Controls the design revision level
r Automatically loads all design resources when a project is opened
r Checks if all project resources are current and available
r Shows the design process flow
r Provides buttons for launching various application
r Places all error and status messages in one window
r Allows setups of all tools from one window
r Automatically translates data while it is moved between tools
r Provides the design status information
r Brings your DOS-based tools into Windows environment

Figure 1-1. ACTIVE-CAD Program Group.
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r Works with network-based workstation EDA tools

The Project Manager window is comprised of six (6) screen areas:

1. The title bar indicates if the window is active. It also displays the cur-
rent project’s name and part being designed.

2. The main menu at the top of the screen allows access to all ACTIVE-
CAD tools and provides for editing, loading, saving and performing
other project management operations

3. The icons below the main menu duplicate some of the main menu
functions to allow quick execution of the most popular operations.
The first three (3) icons are used for project management, and the re-
maining seven icons are used for activating various ACTIVE-CAD
tools.

4. The Hierarchy Browser field shows the hierarchical project structure,
including schematic sheets and macros.

5. The Design Process Flowchart includes buttons for direct control of
EDA tools involved in the current project. This flowchart may look
different for different projects. For example, the XILINX Project Man-
ager will look completely different from the one for Cypress.

Figure 1-2. Project Manager.
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6. The field at the bottom of the screen lists messages from tools involved
in the design process . The left-most column of the message identifies
the EDA tool that has generated the associated message.

You can open a design by starting any ACTIVE-CAD application. Each
of them will automatically invoke the Project Manager widow in Figure
1-2.

Note: To double-click means to press on the left mouse button twice in
rapid succession.

The Project Manager shown in Figure 1-2 is the design process manager.
It displays all available software tools that may be used for the selected
design type or application. Clicking on the Design Info button displays a
window with information on design status and presence/validity of the
design files.

The Project Manager provides automated data transfer between tools in-
volved in processing your designs. Several examples of the Project Man-
ager windows are shown and described in reference to the specific
design applications (see Xilinx Applications, Actel Applications, etc.).

NOTE: Clicking on a button in the Project Manager flowchart, automat-
ically launches the selected application and feeds the input design data.

Clicking on the ACTIVE-CAD icon displays Project Manager screen in
Figure 1-2. Activating any other application will produce a minimized
Project Manager in the taskbar of Windows 95 and a minimized applica-
tion icon in Windows 3.1.

Basic Design Operations
To speed the most popular design operations the New Project , Open
Project and Libraries operations have their own icons, located below the
File menu.

Figure 1-3. Design Manager Icons.
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Starting A New Project

To start a new project click on the the New Project button , which is
located in the top left-hand corner of the Project Manager window. In re-
sponse, ACTIVE-CAD opens the New Project window. To set up the
new project environment, select the following items:

1. Enter the project’s name into the Name field.

2. Select the project directory. Typically, you should use the Projects direc-
tory that is listed by the prompt. If a different directory is needed,
enter into the Directory field the new project’s directory or click on
the Browse option to select the desired directory from another disk.

3. Click on the Type field and select the project type from a list provided
by ACTIVE-CAD. The design Type will determine the Project Man-
ager’s flowchart and its control button arrangement.

4. Select the Family, Part and Speed options when available for the the se-
lected ASIC, FPGA and CPLD family.

5. Click on the OK button to complete the new project selection. All your
entries and selections will appear in the Project Manager’s title bar.

NOTE: If you are using ACTIVE-CAD for the first time, you are given the
choice of creating a new project or opening the existing one.

ACTIVE-CAD is designed to work with one project at a time. The project
is a set of resources like schematics, netlists, libraries, test vectors, etc., se-
lected for the specific design.

The following is a typical design flow:

r Open a new project in Project Manager

Figure 1-4. New Project Window.
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r Create a schematic using the Schematic Editor
r Start the Simulator
r Select test points for applying test vectors
r Design test vectors
r Exercise the schematic design with the test vectors
r Save and print design analysis results

After each design session, save the project so that it can be used the next
time around. When you open a project, ACTIVE-CAD will automatically
load the previously saved schematic to the Schematic Editor.

Project contents are stored in a file with a *.PDF extension. This file is lo-
cated in the ACTIVE\PROJECTS directory. The actual project files are
stored in separate project directories, called the Project Working directo-
ries.

Once the new project type is selected, the Project Manager will automat-
ically display a new flowchart with control buttons for handling all avail-
able programs for the selected design type.

NOTE: The Project Manager creates all necessary directories and files
to start a new project.

Opening An Existing Design

To open an existing design, click on the icon. In response, ACTIVE-
CAD displays the Open Project window (Figure 1-5).

Figure 1-5. Open Project Window.
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The last project’s name is displayed at the top of the window. To select
another project from the Open Project window, double-click on the se-
lected project in the Projects field or select the project with the mouse
pointer and then click on the Open button.

The Directories field lists all hard drives in the systems and all directo-
ries of the selected drive. You can access any project residing in these di-
rectories, using the standard Windows procedures.

NOTE: Invoking any ACTIVE-CAD application always starts the Project
Manager which completely restores the last project you have been work-
ing on.

Selecting Project’s Libraries

To select project’s libraries, click on the Project Libraries icon , or
click on the Project Libraries option in the File menu of the simulator or
schematic editor and the window in Figure 1-6 will appear. The Project
libraries window (on the right) lists all libraries assigned to the current
project. The Attached libraries window (on the left) lists all libraries that
are available in the ACTIVE-CAD system and which can be added to the
current project. The term attached library means that ACTIVE-CAD
knows where the library is located.

Only the project libraries are used when you draw a schematic or load
your netlist to the simulator. If some IC models are missing, verify which
libraries are currently selected and add additional libraries if necessary.

Figure 1-6. Selecting Project Libraries.
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Add only those libraries that will actually be used. Removing libraries
that are not used will speed up the component search.

To add a new library, select it from the left-hand window and click on
the Add button. To remove a library from the current project, select it
from the right-hand window and click the Remove button.

The order of the libraries in the Project Libraries window determines the
sequence in which ACTIVE-CAD searches libraries for the components
in your design. To reorder libraries, click on the library to be moved and
then press on the Reorder button. Next, click over the location where the
selected library should be inserted.

NOTE: The current project name is also included in the library listing.
This library contains all the components that you have created with the
help of VHDL modeling tools or by defining a new part or macro as a hier-
archical symbol netlist.

Attaching Libraries
The libraries displayed in the left-hand window in Figure 1-6 are the
ones that are currently attached to the system. ACTIVE-CAD keeps a re-
cord of where the libraries are located on the hard disk or on the net-
work, and the term attached means that ACTIVE-CAD knows exactly
where the libraries are located.

There are two types of libraries:

r The system libraries, which are provided on the installation diskettes or
CD ROM. These libraries are typically located in the ACTIVE\SYSLIB
directory. Models in these libraries cannot be modified by the user.

r The project libraries, which are created by the user. They store hierar-
chical macros and IC models created by copying and modifying the
system library models. The modified components from system librar-
ies may have changed pins, part name or timing but their functional
behavior is the same as the model from which they were created.

The models created by modifying components from system libraries can
be used only in conjunction with the keylock under which control they
were generated. For large company installations, you should use the net-
work ACTIVE-CAD keylocks because they will make the models avail-
able to all designers in the company.

The system libraries are automatically attached by the installation pro-
gram. However, if you change the directory where the libraries are lo-
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cated or receive the library without the installation program, you may
need to use the Attach option to add the library to the system. Press the
Attach button in Figure 1-6 and the Attach Library window (Figure 1-7)
will appear.

Select in the Attach Library window the drive where new library is lo-
cated and press the Update button. A list of available libraries on the se-
lected drive is displayed in the Libraries Found window. Only the
libraries that are not yet attached are displayed. Choose the desired li-
braries with the cursor and press the Attach button. The selected libraries
will be added to the libraries listed in the Attached Libraries field of the
Libraries window ( Figure 1-6 ).

You can attach project libraries from other ACTIVE-CAD installations.
For example, if one ACTIVE-CAD user creates a library with custom
simulation models, the library can be copied to a diskette and installed
on another ACTIVE-CAD system.

For more information on library operations, please refer to the File Menu
section of the current chapter, or see the Library Manager chapter of this
manual.

Saving a Project
The editing of the project resources or libraries, automatically updates
the current project configuration. This configuration is saved upon clos-

Figure 1-7. Attach Library Window.
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ing the Project Manager. The designs developed in various applications
controlled by the Project Manager can only be saved by the Save options
of these applications. They cannot be saved from the Project Manager.

NOTE: You are prompted for saving changed documents before quitting
the Project Manager.

Title Bar
The Project Manager’s title bar performs the following functions:

r Color indicates if the window is active. Gray indicates a deactivated
window.

r Lists the name of the ALDEC software. This name may change depend-
ing upon the OEM version of the software. However, the overall
operation generally will remain the same.

r Lists the current project’s name in square brackets “[ ]”.
r Lists the selected device and its packaging for a device-level design.
r It is used for dragging the application window to various screen loca-

tions.

The title bar is shown in detail in the Listing Of The Main Menu Options
(Figure 1-8).

Main Menu
The main menu is comprised of six (6) sub-menus, which group opera-
tions on applications and project files. The most popular operations can
be activated by clicking on the applications icons, provided below the
main menu listing.

File Menu
The File menu is listed in the figure below.

Figure 1-8. Main Menu Options.
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File|New Project option

The New Project option invokes the New Project window which has
been described in the Starting A New Project section of this chapter.

File|Open Project option

The Open Project option invokes the Open Project window which has
been described in the Opening An Existing Design section of this chapter.

File|Copy Project

Copying a Project

The project configuration files contain information about the location of
various project resources and libraries. Therefore, do not manually copy
these files to a different location, because they will not be found by
ACTIVE-CAD. Instead, select the Copy Project option from the Project
Manager’s File menu. Enter the new design name and its directory in the
Copy Project window and press the OK button.

Figure 1-9. File Menu Options.
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File|Delete Project

Deleting a Project

The project files may be located in many directories. Therefore, do not
manually delete project files because you may miss quite a few of them.
Instead, select a project from the project list and press the Delete Project
button. This deletes all files associated with the selected project.

NOTE: You cannot delete the current project. First, open another project,
and then delete the previous one

File|Archive

One of the most important functions is archiving design files. The
File|Archive option displays the Save Current State window (Figure 1-
11), which allows saving each file with detailed manually entered com-
ments (Comment field). The associated comment files, such as Release
Notice, Application Notice, Engineering Change Order, and similar docu-
ments that control the design progress and its quality may be entered in
the Additional files field.

Enter the
destination
directory
HERE

Figure 1-10. Copy Project Window.
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The associated comment files, can be entered by hand by specifying their
directory and file names in the Additional files field. Clicking on the
Add File button allows browsing of network directories and automatic
assignment of other related documents.

Figure 1-11. Save Current State Window.

Figure 1-12. Add Archive Files Window.
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File|Project Info

Project Info

This option displays key information about the current project (Figure 1-
13). To exit this option, press the OK button.

File|Libraries

Selecting Project Libraries

Clicking o this option displays the Libraries window, which lists in the
Attached Libraries field all available libraries. The libraries that actually
have been used in the current project are listed in the Project Libraries
field.

Since ACTIVE-CAD searches for components starting from the top-most
library in the Project Library field, the order of the libraries in the Pro-
ject Libraries field may be very important, particularly if you have two
devices with the same name but different characteristics. Also, to speed
the software operation, the most often used components should have
their library listed at the top of the Project Libraries field.

To reorder libraries, click on the library in the Project Libraries field,
which will highlight or enable the Reorder button. Clicking on the Reor-
der button and then on the desired location within the Project Libraries
field, will move the selected library to its new position.

To add a library to the current project, click on the selected library in the
Attached Libraries field, and then click on the Add button. The library
will be listed at the bottom of the Project Libraries field. You can use the
reorder option to place the newly added library at the desired priority
level.

To add multiple libraries with one Add button operation, first select
them by pressing the Shift key and clicking on the libraries in the At-

Figure 1-13. Project Information Window.
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tached Libraries field. The selected libraries will turn blue. Clicking on
the Add button moves the selected libraries to the Project Libraries field.

To remove libraries from the project, select them in the Project Libraries
field and then click on the Remove button.

NOTE: Removing a library may destroy the design if its components
have been used in the project. You can safely remove only these librar-
ies which components have not been used in the project.

The Attached Libraries field list all libraries that can be used by a pro-
ject. The Attach button allows searching network directories for addi-
tional libraries which have not been yet attached to the ACTIVE-CAD
software. The process of attaching libraries is comprised of three (3) steps:

1. Click on the Attach button in the Libraries window (Figure 1-14). A list-
ing of all network hard drives will be displayed in the Attached Li-
brary window (Figure 1-15).

2. Click on the drive that has the desired additional libraries, and then
click on the Update button. The additional libraries will be listed in
the Libraries Found field.

3. Select the library or libraries from the Libraries Found field and click
on the Attach button.

The selected libraries will be automatically added to the ACTIVE-CAD
resources and will be immediately available to all current and future pro-
jects.

Figure 1-14. Operations On Project Libraries.
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The Lib Manager button activates the Library Manager application
which is used for operations on parts and libraries. A detailed descrip-
tion of this application is provided in the Library Manager chapter.

File|Project Type

Redefining Project Type

Each time a specific technology such as XILINX, ALTERA or ACTEL is
selected for your project, the Project Manager produces a specific design
process flowchart for that technology. To switch to another type of the
design environment, e.g. from XILINX 3000 to XILINX 5200, or from AL-
TERA to XILINX, use the File|Type option which activates the Change
Project Configuration window (Figure 1-16). Clicking in the Available
Types, Family, Part, and other fields allows selection of new options.

Figure 1-15. Attaching Additional Libraries.

Figure 1-16. Changing Project Configuration.
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Document Menu
The Document menu (Figure 1-17) provides for such operations on docu-
ments as adding schematic or “bubble” diagram sheets from other pro-
jects, etc. It also allows adding files generated in other projects such as
JEDEC or hex files, VHDL source code files, test vector files and similar.

Document|Add

Adding Documents To The Project

This option allows adding additional document files to the current pro-
ject. Clicking on this option displays the Select Document window (Fig-
ure 1-18). Select from the Folders field the directory which holds the
documents that you want to add to the current project. Double clicking
on a directory in the Folders field displays all documents in that direc-
tory that have the file name extension selected in the List file types win-
dow.

Click (select) in the File name field on the document that you want to
add to the current project, followed by pressing of the OK button.

Figure 1-17. Document Menu Options.
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Document|Remove

Only an entire document file can be removed from a project. You cannot
remove a section or subsection of any document.

To remove a document from the current project, select it from the hierar-
chical project tree and click on the Document|Remove option. If the
item is an independent design file, Project Manager will display an advi-
sory message (Figure 1-19). If the selected item is not an independent file,
an advisory message will be displayed at the bottom of the Project Man-
ager.

Document|Open

Selecting a document from the hierarchical project tree (Hierarchy
Browser field) and clicking on the Document|Open option will open the
document and the associated application. For example, clicking on a

Figure 1-18. Selecting Additional Documents.

Figure 1-19. Document Removal Prompt Message.

1-18 Document Menu



schematic sheet will open both the selected schematic sheet and the sche-
matic editor.

Document|Info...

Basic information about the selected document (source file name, last
changes date, library, document type) can be displayed by invoking this
option.

Document|Add resource

Because adding project resources is of great importance, a special section
entitled Managing Project Resources has been added at the end of this
chapter.

Document|Simulation Netlist

This option prepares the simulator environment. Clicking on the Docu-
ment|Simulation Netlist option displays the Project Netlist Configura-
tion window (Figure 1-20). Selecting the Schematic Netlist option and
clicking on the OK button will automatically generate a netlist for the on-
line simulator. However, the simulator will not be activated.

To simulate externally generated netlists, e.g. by other schematic editors
or logic synthesis tools, select the External Netlist option. Next:

1. Select the desired netlist format from the External Netlist Format field.

2. Click on the Select Netlist button to display the Select Netlist window.

Select from that window the desired file name to be simulated. You may
need to select the appropriate Drive, Folders, Type of file (file name ex-
tension) and the file name. These are typical Windows operations used
during file access.

Figure 1-20. Selecting A Netlist For Simulation.
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Hierarchy Tree Operations

Four options from the Document menu control the display of the hierar-
chical project structure. Highlighting a hierarchical level and clicking on
the option allows selective display of the hierarchical project structure.

r The Expand One Level [+] option, displays the next hierarchical level
within the selected hierarchical macro.

r The Expand Branch [*] option displays all hierarchical levels within the
selected hierarchical macro

r The Expand All [Ctrl + *]option displays all hierarchical levels within
the entire project.

r The Collapse Branch [-] option hides all hierarchical levels below the
selected macro.

Figure 1-21. Selecting An External Simulation Netlist.

Figure 1-22. Hierarchical Project Tree Example.
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Document|Find Object

This options allows searching for a symbol, pin or net name in the whole
hierarchy. When the object id found, Schematic Editor is opened and the
object is highlighted.

View Menu
The View menu controls display of options within the Project Manager.

r Toolbar - turns on/off the icons located below the main menu
r Status Bar - turns on/off the message bar at the bottom of the screen
r Lines - turns on/off the lines within the hierarchical tree
r Sort by References - sorts all hierarchical macros by references
r Sort by Names - sorts hierarchical macros by names

Applications Menu
The Applications menu (Figure 1-25) allows launching ACTIVE-CAD ap-
plications. The applications can also be started from the icons located be-
low the main menu (Figure 1-24).

r Schematic Editor - allows schematic designs
r State Editor - provides for design entry in the form of graphical bubble

diagrams
r HDL Editor - allows ABEL and VHDL design entries
r Logic Simulator - starts functional and timing logic simulators
r Library Manager - allows management of libraries, macros and models

Figure 1-23. Project Manager Display Control.

Figure 1-24. Application Icons.
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r Symbol Editor - used for creating new cell, macro and device sym-
bols

Messages Menu
This menu includes two (2) options:

r Preferences - controls which messages will be displayed in the Mes-
sages window, located at the bottom of the Project Manager window.

r Clear - clears all messages

Selecting the Preferences option displays the Message Preferences win-
dow (Figure 1-26), which has two (2) fields:

Figure 1-25. Applications Menu Options.

Figure 1-26. Selecting Messages For Display.
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1. Output field controls how and where the messages will be displayed
and stored

r Window displays the messages in the Project Manager window
r File saves the messages on file
r Overwrite overwrites the old messages with new ones
r Append keeps track of all messages in one file
r Lines sets the limit on the design file size

2. Show field controls what will be displayed

r Errors - displays all errors in red
r Warnings - displays all warnings in blue
r Comments - displays design comments in black
r Info Levels (1-3) - displays comments about the progress of software

processing; checking only the Level 1 box displays the most impor-
tant messages - checking all boxes displays all messages.

Help menu
Displays the current version of the Project Manager. An example of such
Help menu is shown below (Figure 1-27).

Figure 1-27. Project Manager Help Window.
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Project Management

General
A project is a set of resources and libraries configured for a specific de-
sign.

The project resources (schematics, netlists, VHDL source code files,
JEDEC files, etc.) associated with the design are stored in the Project
Working Directory. They are created by ACTIVE-CAD applications or
imported from external programs. All project resources that are created
during the design sessions are automatically attached to the current pro-
ject. You can also manually add, browse or delete project resources.

Project libraries should be configured to match your design needs. To
speed the design process, select only those libraries that you will actually
use. If several libraries list the same part name, you can specify which li-
brary will be used, by arranging the order of libraries.

NOTE: If there are duplicate names in the libraries, the project libraries
will be searched for these parts starting from the top-most listed library.

Each project has a configuration file that stores the information about the
location of the project resources and libraries. This file has the *.PDF ex-
tension and is typically stored in the ACTIVE\PROJECTS directory. The
location of this directory is set in the SUSIE.INI file as the PRO-
JECTS=C:\ACTIVE\PROJECTS setting.

Managing Project Resources
ACTIVE-CAD is a design database management system. This database is
comprised of various design files called project resources. The Table 1-1
lists all resources that can be used with ACTIVE-CAD programs.

Any existing ACTIVE-CAD resources can be added to or removed from
the current project configuration by using the Document|Add Re-
sources menu option. When the Project Resources window (Figure 1-28)
appears, click on the arrow button in the Resource Type listbox and se-
lect the desired resource type, e.g. test vectors. A list of currently at-
tached test vector files will be displayed in the Existing Project
Resources field.
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Table 1-1. ACTIVE-CAD Project Resources.

Resource Name Filename
Extension

Schematic Sheets* *.SCH

Schematic Macros *.MAC

Simulator Macros *.MAC

VHDL Source Codes *.HDL

Simulation Session Files *.DES

PLD JEDEC Fuse Maps *.JED

ASCII Test Vectors *.ASC

Binary Test Vectors *.TIM

Memory Contents *.HEX, *.BIN

Internal State Editor Screens *.SCR

The Additional resources window displays all files located in the cur-
rent directory that have the same file name extension as the selected pro-
ject resource. To list files in another directory, change directories using
the Directories window on the right-hand side. Double-clicking on the
selected directory will display all files with the selected file name exten-
sion, which reside in that directory. These files will instantly appear in
the Additional Resources Available In Directory field.

Select the desired file name and then press the Copy or Link button to
add the resource to the current project. Copy will import the resource
and Link will attach the resource.
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The Copy option makes a copy of the imported file in the project work-
ing directory. For example, if you import an ASCII timing file using the
Copy button, the file will be copied to the project working directory. If
the original file is ever changed or deleted, it will not affect the current
project. The Copy all button copies all resources displayed in the se-
lected directory to the project directory.

The Link button attaches the selected resource to the current project, but
does not make a copy of the resource file. It will be used directly from
the directory where it is located at the time you import it. This means
that every time the original file is changed, your project will be using a
new version automatically. For example, if you link a JEDEC file,
ACTIVE-CAD will load the latest version of the file automatically. If the
file is moved or deleted, then ACTIVE-CAD will no longer be able to
find a resource file and it has to be linked again. The Link all button
links all resource files in the selected directory.

To remove existing resources from the current project, use the Remove
or Remove all buttons. If a resource file was copied, ACTIVE-CAD will
delete the file from the disk. If it was linked, the file will not be deleted.

Figure 1-28. Selecting Project Resources.

1-26 Managing Project Resources



Simulating External Netlist
The simulator is an independent application which can simulate designs
entered in any schematic editor. To load such a design into simulator,
use the Document|Simulation Netlist menu option in the Project Man-
ager .

Select the External netlist option in the new Project Netlist Configura-
tion window. Next, select the netlist format and then click on the Select
Netlist button to locate the desired netlist file on the disk. All files with
the selected file name extension will be automatically displayed.

To switch the project back to the schematic netlist, select the Schematic
Netlist option in the Project Netlist Configuration window.

Post-Layout FPGA Netlists
A special case of the external netlist is a netlist that was originally gener-
ated from the ACTIVE-CAD schematic editor and then modified by
some layout tools. For example, you may have a Xilinx FPGA design that
has been entered on the schematic and then routed by Xilinx layout tools.
The post-layout netlist is generally similar to the schematic netlist but
contains some additional information about circuit timing delays. This
information is required for the timing verification of the design and has
to be loaded directly to the simulator.

To simulate the routed netlist and be able to view the schematic at the
same time, select the External netlist in the Project Netlist Configura-
tion window. This will allow you to load an external netlist to simulator
and simulate the timing delays from the routed netlist. You can also
place and view the simulation probes (LED lamps) directly on the sche-
matic. However, the schematic changes will not show in the simulator.

Figure 1-29. Selecting External Netlist Format.
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NOTE: When simulating routed designs some probes from the pre-rout-
ing test vector files may not be displayed during the post-routing simula-
tion. This is usually due to the differences between the schematic and
the routed netlist. Generally, the net names are preserved by all layout
tools and you can view their probes on the schematic.

1-28 Post-Layout FPGA Netlists
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